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Preface 
 
 

 
Izenda Reports enables you to easily access your databases directly and quickly transform raw data into 

useful and readily understood information. With Reports you can extract the information you need from 

one or more related tables and format it into tables, reports, or charts. You can view the resulting 

report in your Web-browser and then print it. You can also export reports in several formats, including 

Microsoft Word, Microsoft Excel, and Adobe PDF. 

 

Imagine that your boss has asked for a list of outstanding sales orders for each customer. You know 

that your database has a table called Customers, and another table called Orders, and that they can be 

linked together using the common field called CustomerID. Using Reports, you can “join” the two tables 

and then choose the data fields you need, such as customer name, phone number, order number, order 

date, and order amount. You can use a filter to select only open orders. You can sort the data by 

customer. Finally you can view or print the report, create the report as a PDF file, or output it to Excel. 

It is so easy. It is so fast. Your boss will be amazed. 

 

This user manual will step you through each simple process in using Reports, and provide you with 

what you need to know to create your queries and reports. Any data that your application developer 

has included in the database can be accessible to you in creating ad hoc reports. 
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1.0  INTRODUCTION TO IZENDA REPORTS 
 

Izenda Reports is a reporting solution that allows you to design and run reports from a web browser.  It 

consists of a Report List, Report Viewer, and Report Designer and other pages that list and view 

reports. 
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2.0 QUICK START GUIDE 
 

2.1 Building your first report 

• Navigate to the Report List page (http://host/yourApp/ReportList.aspx)  

• Click the "Design A New Report" link  

 
Click to design a new report 

 

• Select a report data source in the "Data Sources" tab (the drop-down contains tables 

and views) like Invoices or Orders  

 
Figure 2-1 Select Views and Tables 
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• Select one or more fields, such as Lastname, or OrderId, from the "Field" drop-downs  

 
Figure 2-2 Select Fields 

• Click the "Preview" tab  

 
Figure 2-3 Click the preview tab 
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• Click the "Save" button to save your report  

 
Figure 2-4 Click “Save” to save your report 

• Enter a name and category(optional) in the "Save" dialog box  

 
Figure 2-5 Enter a report name and/or report category in the dialog box 

You now have your first functional report. This is a very basic example, and Izenda Reports 
offers far more capabilities.  
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3.0 THE REPORT LIST 
 

The Report List is first page that you, the user, typically interacts with unless given a link to a specific 

report. This page displays the list of reports. By default, it displays uncategorized reports first in 

alphabetical order and then displays an alphabetized list of the reports by category.  

 

Report links are shown in blue below. Clicking on a report link loads the report into the report viewer.  

You can also click on the delete and modify buttons, shown by the red arrow below (Figure 3-1), to 

delete the report and load the report into the Report Designer to be modified. 

 

 
Figure 3-1 Typical Report List 

 

Using this page (depending on your administrator’s setup), you may be able to: 

 

• view an existing report 

• create a new report 
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• delete an existing report 

• modify an existing report 

 

All of these options depend upon how your report administrator has configured Izenda Reports. Some, 

none or all of these options may be available to you. 

 

 

3.1 Viewing a Report 
 

 
Figure 3-2 Clickable Report Links 

The report names are hyper-links which are clicked to load the report into the report viewer.   

 
3.2 The “Design a New Report” Link 

 

 
Figure 3-3 Design a New Report Link 

 

This is a special link. Clicking this link takes you to the report designer where you can create a new 

report. 
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3.3 The Delete and Modify Buttons 
 

 
Figure 3-4 Report Link, Delete & Modify Buttons 

The delete button   allows you to delete a report.  Clicking it will pop-up a dialog box confirming 

your choice to delete. 

 

The modify button   allows you to modify the report by loading the report in the report designer.  

Clicking it will load the report into the report designer. 
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4.0 THE REPORT VIEWER 
 

 

The Report Viewer is used to view the reports that are listed in the Report List. The user typically 

interacts with this page in order to view reports. When loaded, the page displays the report with a 

menu of options on the top of the page. 

 

 

 
Figure 4-1 Report Viewer 

 

 

The Report Viewer buttons allow you to do common tasks associated with viewing a report. 

Report Viewer Buttons 

Button Name Function 

Export Exports the report in the selected format 

Modify Report Switches to Designer so the user can modify the report 

Report List Displays the list of reports 

Show/Hide Filters Allows the user to either display or hide the filters in the Report Viewer 

Update Results Allows the user to add update the report results after adding/removing filters or 

fields 

Back Allows the user to return to the previous page 

 

 

 

 

 

 

The dropdowns in the Report Viewer also add the ability to add filters, fields and change the export 

type. 

 

Report  Viewer Drop-downs 

Dropdown Function 

Reports Allows the user to select a different report to view 

Results Allows the user to select the number of results in the report shown on the screen (using 

powers of 10) 

Add Field Adds a new field to the report 

Export Type Determines what format to export the report in 

Filter Field Selects the field to be filtered 
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Operator Allows user to choose an operator for the filter

 

Users can filter in the Report Viewer by using the filter menu shown in 

to select filter fields and operators, and to add filters If ne

 

Figure 4-2 Report Viewer Filters 
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Allows user to choose an operator for the filter 

Users can filter in the Report Viewer by using the filter menu shown in Figure 4-2. They have the ability 

to select filter fields and operators, and to add filters If needed. 
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. They have the ability 
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5.0 THE REPORT DESIGNER 
 

The Report Designer (Figure 5-1) provides the means to specify parameters for the table(s) of your 

databases.  

 

 
Figure 5-1 Report Designer Toolbar 

 

5.1 Reports Tab 
 

The Reports tab (Figure 5-2) provides another list of created reports. 
 

 
Figure 5-2 Reports Tab 

 

5.2 Data Sources Tab 
 

The Data Sources tab (Figure 5-3) shows which tables and views are already stored in the database. 

and provides a choice of which table to view or which tables you would like to join. To join two tables 

and/or views, they must have fields with identical entries. For example, both the Customers and the 

Orders tables have the same CustomerID field that contains one of several possible entries: beverages, 

condiments, dairy products, seafood, and so on. 



Izenda Reports                User’s Guide 
 

 

Izenda Reports User’s Guide v5.4   
15 

 
Figure 5-3 Data Sources Tab 

5.2.1 Table Dropdown Menu 

 

The Table dropdown menu (Figure 5-4) is a list of the tables and views available to the user, as shown 

in Figure 4. Select the desired table/view to preview. To join multiple tables or views that have a field 

with identical entries, select those tables/views.  

NOTE: A view is a set of tables that have already been joined. 
 

 
Figure 5-4 Table Dropdown Menu 
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5.2.2 Join Field Dropdown Menu

 

The Join Field dropdown menu (Figure 

the Table dropdown menu to the left. Select the fi

needs to be joined with. 
 

Figure 

 

5.2.3 Foreign Table Dropdown Menu

 

The Foreign Table dropdown menu (

the Table dropdown menu, other than the one in that row. Select the table/view to join the table/view 

in that row. 
 

Figure 
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Join Field Dropdown Menu 

Figure 5-5) is a list of the fields contained in the table/view selected in 

dropdown menu to the left. Select the field that has identical entries as the table/view that it 

Figure 5-5 Join Field Dropdown Menu 

Foreign Table Dropdown Menu 

dropdown menu (Figure 5-6) is a list of the tables/views that have been selected in 

dropdown menu, other than the one in that row. Select the table/view to join the table/view 

Figure 5-6 Foreign Table Dropdown Menu 
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) is a list of the fields contained in the table/view selected in 

eld that has identical entries as the table/view that it 

 

is a list of the tables/views that have been selected in 

dropdown menu, other than the one in that row. Select the table/view to join the table/view 
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5.2.4 Field Dropdown Menu 

 

The Field dropdown menu (Figure 5-7) is a list of fields in the table/view that are selected in the 

Foreign Table dropdown menu to the left. Select the field to join with the table/view in that row. 
 

 
Figure 5-7 Field Dropdown Menu 

 

5.2.5 Join Type Dropdown Menu 

 

The Join Type dropdown menu (Figure 5-8) is a list of the available joining methods. The “Inner” 

method discards any objects from the joint fields that do not have an identical match. The “Left” 

method still displays those without an identical match 
 

 
Figure 5-8 Join Type Dropdown Menu 
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5.2.6 Function Buttons of Data Sources Tab 

 

From examples in sections 2.2.2 to 2.2.5, two tables, Customers and Orders,have been used. 

CustomerId is the join field of both the Customers and Orders table and Inner (direct) is the join type. 

  
 

 
Figure 5-9 Function Buttons 

 

The ,  , and  function buttons are defined in Table 2 below. 
 
 

Icons Control Name Description 

 Delete button Click this button to delete the row the 

button is on. 

 Insert Row 

button (above) 

Click this button to insert a row above the 

row the button is on. 

 Insert Row 

button(below) 

Click this button to insert a row below the 

row the button is on. 
 

Table 2 Function Buttons of Data Sources Tab 
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5.3 Fields Tab 
 

In the Fields tab, choose which field of the table/view in the Data Sources tab to display, as well as 

what format is desired.  

 

 
Figure 5-10 Fields Tab 

 

5.3.1 Field Dropdown Menu 

 

The Field dropdown menu (Figure 5-11) is a list of the available fields in the table/view that is selected 

in the Data Sources tab. If joining tables/view, the title of the table/view that the field is from appears 

in parenthesis next to the name of the field. Select the fields to display. 
 

 
Figure 5-11 Field Dropdown Menu 
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5.3.2 Description 

 

Inputs the description of the field selected in the Field dropdown menu to the left. The description 

appears as the new title of the field when the table/view is displayed (Figure 5-12).  

 

NOTE: A default description always appears in this box, but may be edited. 
 
 

 
Figure 5-12 Description   
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5.3.3 Sort(a-z), Sort(z-a), and

 

Figure 5-13 shows the Sort(a-z), Sort(z

 
 

Figure 5-13 Sort, Group, and 

 

Table 3 explains the Sort, Group, and 

 

Features 

Sort (a-z) check box Check this box if you want the table/view to be sorted by 

the field selected in the 

in ascending order

Sort (z-a) check box Check this box if you want the table/view to be sorted by 

the field selected in the 

in descending order.

VG check box Check this box to 

in the 

 

Function dropdown 

menu 

Function

Group

See 
 

Table 3  Description of Sort, Group, and
  

               

 

Izenda Reports User’s Guide v5.4  

, and VG Check Boxes and Function Dropdown Menu

Sort(z-a), and VG Check Boxes and Function dropdown menu.

Sort, Group, and VG Check Boxes and Function Dropdown Menu

Sort, Group, and VG Check Boxes and Function dropdown menu features.

Description 

Check this box if you want the table/view to be sorted by 

the field selected in the Field dropdown menu to the left

in ascending order. 

Check this box if you want the table/view to be sorted by 

the field selected in the Field dropdown menu to the left 

in descending order. 

Check this box to change the column for the field selected 

in the Field dropdown menu to the left into subheadings

 

Functions can be chosen from the dropdown menu

Group option is selected a group of fields can be 

See Function Descriptions for more information.

iption of Sort, Group, and VG Check Boxes and Dropdown Menu
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Check Boxes and Function Dropdown Menu 

dropdown menu. 

 
Check Boxes and Function Dropdown Menu 

dropdown menu features. 

Check this box if you want the table/view to be sorted by 

dropdown menu to the left 

Check this box if you want the table/view to be sorted by 

dropdown menu to the left 

field selected 

into subheadings 

can be chosen from the dropdown menu. If the 

option is selected a group of fields can be created. 

for more information. 

Check Boxes and Dropdown Menu 
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5.3.4 Width 

 

The Width is shown in Figure 5-14. Enter the width (default unit is px) of the column in the table 

produced that holds the values for the field selected in the Field dropdown menu directly to the left. 

 

 

 
Figure 5-14 Width and Format Dropdown Menu 

 

 
Figure 5-15 Date Format Dropdown Menu 

5.3.5 Format Dropdown Menu 

 

The Format dropdown menu is a list of formats for the entries of the field selected in the Field 

dropdown menu directly to the left to appear in. 

 

Format Description Examples 

0,000 

 

 

Displays the number as a whole 

number. 

1 

123 

1,234 

1,234,567  

$0.00 

 

 

Displays the number as a 

currency 

$123.45 

$0.12 

0.0 

 

 

Displays the number with one 

decimal place 

123.5 

0.00 Displays the number with two 123.46 
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decimal places 

0.000 

 

 

Displays the number with three 

decimal places 

123.456 

0% Displays the number as a 

percentage 

1% 

12% 

If the field in the Field dropdown menu directly to the left is a date, the Format dropdown menu will 

look like this: 

 

Format Description Examples 

Short Date Displays the date using the 

mm/dd/yyyy format 

 

8/1/1996 

Long Date Displays the day of the week, 

month, numeric day, and the 

year 

Friday, August 09, 1996 

Short Time Displays time as hh:mm AM/PM 

 

 

12:34 AM 

 

Long Time Displays time as hh:mm:ss 

AM/PM 

 

12:34:56 PM 

Full(short) Displays the Long Date format, 

followed by the Short Time 

format 

Friday, August 30, 1996 4:34 PM 

Full(long) Displays the Long Date format, 

followed by the Long Time 

format 

Wednesday, October 23, 1996 

2:28:37 AM 

Gen(short) Displays the Short Date format, 

followed by the Short Time 

format 

3/12/1996 7:45 PM 

Gen(long) Displays the Short Date format, 

followed by the Long Time 

format 

2/27/1996 12:45:13 AM 

 
 

5.3.6 Function Buttons of Fields Tab 

 

The  ,  , and  function buttons shown in Figure 5-16 are for the rows that they are in. 
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Figure 5-16 Function Buttons of Fields Tab 

 

 

Table 4 describes the function buttons of the Fields tab. 
 

Icons Control Name Description 

 Delete button Click this button to delete the row the button is on. 

 Insert Row 

button (above) 

Click this button to insert a row above the row the button is 

on. 

 Insert Row 

button (below) 

Click this button to insert a row below the row the button is 

on. 

 Move one 

Row(up) 

Click this button to move the filter one row up. 

 Move one 

Row(down) 

Click this button to move the filter one row down. 

 

Table 4  Function Buttons of Fields Tab 
 
 

5.3.7 Add All Fields From Menu 

 

Figure 5-17 shows the Add All Fields From menu. 
 

 
Figure 5-17 Add All Fields From Menu 

 

Table 5 explains the function of each element of the Add All Fields From menu. 
 

Features Description 

Add All Fields From 

dropdown menu  

List of tables/views selected in the Data Sources tab. 

Add All button  Adds all the fields from the table/view selected in the 

Add All Fields From dropdown menu. 

Remove All button  Removes all the fields from the table/view selected in 

the Add All Fields From dropdown menu. 

 

Table 5 Add All Fields From Menu, Add All / Remove All 
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5.4 Filters Tab 
 

In the Filters tab (Figure 5-18), the fields of the table/view chosen in the Data Sources tab can be 

filtered so that only pertinent entries appear in the table. 
 

 
Figure 5-18 Filters Tab 

 
 

5.4.1 Filter Field Dropdown Menu 

 

The Filter Field dropdown menu (Figure 5-19) is a list of the available fields in the table/view that have 

been selected or created in the Data Sources tab. Select the fields to filter. If joining tables/view, the 

title of the table/view that the field is from appears in parentheses next to the name of the field. 

 

 
Figure 5-19 Field Dropdown Menu 
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5.4.2 Operator Dropdown Menu and Value(s)  

 

Figure 5-20 shows the Operator dropdown menu and value(s) features. 
 

 
Figure 5-20 Operator Dropdown Menu and Value(s). 

 

Table 6 describes the Operator dropdown menu and value(s) features. 
 

Features Description 

Operator dropdown menu List of operations available to perform on field 

selected in the Field dropdown menu to the left. 

Value(s).  

 

Enter the value to which the operation selected in 

the Operator dropdown menu will be applied (for 

example, “Begins With A” only displays items that 

have entries that start with “A” in the selected field). 
 

Table 6 Description of Operator Dropdown Menu and Value(s) 
 

5.4.3 Function Buttons 

 

The ,  ,  ,  and  function buttons of the Filters tab are shown in Figure 5-21. 
 
 

 
Figure 5-21 Function Buttons 
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Table 7 describes the function buttons of the Filters tab. 
 
 

Icons Control Name Description 

 Delete button Click this button to delete the row the button is on. 

 Insert Row 

button (above) 

Click this button to insert a row above the row the button is 

on. 

 Insert Row 

button (below) 

Click this button to insert a row below the row the button is 

on. 

 Move one 

Row(up) 

Click this button to move the filter one row up. 

 Move one 

Row(down) 

Click this button to move the filter one row down. 

 

Table 7 Description of Function Buttons 
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5.5 Summary Tab 
 

In the Summary tab (Figure 5-22), a table can be created that summarizes the chosen fields using 

different functions (for example, Average, Count, Maximum, and so on). You can also make a group of 

fields by choosing the Group option from the Function dropdown menu. 
 

 
Figure 5-22 Summary Tab 

 

5.5.1 Field Dropdown Menu 

 

The Field dropdown menu (Figure 5-23) is a list of available fields in the table/view that have been 

selected/created in the Data Sources tab and that have numeric entries. Select the fields to 

summarize.  
 

 
Figure 5-23 Field Dropdown Menu 

5.5.2 Description 

 

The Description text box (Figure 5-24) inputs the description of the field selected in the Field 

dropdown menu to the left. The description appears as the new title of the field when the Summary 

Table is displayed. 

 



Izenda Reports 
 

Izenda Reports User’s Guide v5.4

NOTE: A default description always appears in this box, but may be edited.

 
 

Figure

 
 

5.5.3 Sort(a-z) Check Box, Sort(

 

The Sort(A) check box, Sort(D) check box,

 

Figure 5-25 Sort Check Box and Function Dropdown Menu

 
 

Table 8 describes the Sort(A) check box
 

Features 

Sort(a-z) check 

box  

 

 

Checking this box causes the table/view to be sorted by the 

field selected in the 

ascending order

 

Sort(z-a) check 

box 

 

 

Checking this box causes the table/view to be sorted by the 

field selected in the 

descending order.
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A default description always appears in this box, but may be edited. 

 
Figure 5-24 Description Text Box 

, Sort(z-a) Check Box and Function Dropdown Menu

check box, and the Function dropdown menu are shown in 

Sort Check Box and Function Dropdown Menu 

check box, Sort(D) check box, and Function dropdown menu features.

Description 

Checking this box causes the table/view to be sorted by the 

field selected in the Field dropdown menu to the left

ascending order. 

Checking this box causes the table/view to be sorted by the 

field selected in the Field dropdown menu to the left in 

descending order. 
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and Function Dropdown Menu 

dropdown menu are shown in Figure 5-25. 

 

dropdown menu features. 

Checking this box causes the table/view to be sorted by the 

dropdown menu to the left in 

Checking this box causes the table/view to be sorted by the 

ropdown menu to the left in 
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Function 

dropdown menu 

Lists the functions that may be applied to the field. (for 

example, choosing Average causes the Summary Table to 

display the average value for the entries in the field selected in 

the Field dropdown menu.) Note:  each selection must be 

either grouped or a function or all can be None. 
 

Table 8 Description of Sort Check Box and Function Dropdown Menu 
 
 

5.5.4 Format Dropdown Menu 

 

This is the same format as the Format Dropdown Menu from the Fields tab. See Section 2.3.5 

5.5.5 Function Buttons 

 

The ,  ,  ,  and  function buttons are shown in Figure 5-26. 
 
 

 
Figure 5-26 Function Buttons 

 

 

Table 9 describes the function buttons. 

 

Icons Control Name Description 

 Delete button Click this button to delete the row the button is on. 

 Insert Row 

button (above) 

Click this button to insert a row above the row the button is 

on. 

 Insert Row 

button (below) 

Click this button to insert a row below the row the button is 

on. 

 Move one 

Row(up) 

Click this button to move the filter one row up. 

 Move one 

Row(down) 

Click this button to move the filter one row down. 

 
 

Table 9  Description of Function Buttons 
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5.6 Chart Tab 
 

In the Chart tab (Figure 5-27), a chart can be created using the data in the table/view selected on the 

Data Sources tab. 
 

5.6.1 None Selection 

 

When the chart type (Figure 5-28) is 
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), a chart can be created using the data in the table/view selected on the 

Figure 5-27 Chart Tab 

) is None, no chart appears. 

 
Figure 5-28 None Selection 
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), a chart can be created using the data in the table/view selected on the 
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5.6.2 Trend Selection 

 

When the chart type is Trend (Figure 
 

 

Table 11 describes the features of the 

 

Features 

Trend chart  By choosing chart type 

Date dropdown 

menu  

Choose any field of date format like birth date, join date, and so 

on. 

Value dropdown 

menu 

Choose any value from the dropd

 

Table 11  Description of Trend Chart Type
 

5.6.3 Pie Selection 

 

Figure 5-30 shows the Pie (chart) selection menu of the 
 

Figure 
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Figure 5-29), the chart appears in Trend format. 

Figure 5-29 Trend Selection 

Table 11 describes the features of the Trend chart type selection. 

Description 

By choosing chart type Trend, the chart appears in Trend

Choose any field of date format like birth date, join date, and so 

Choose any value from the dropdown list. 

Table 11  Description of Trend Chart Type 

(chart) selection menu of the Chart tab. 

Figure 5-30 Pie (Chart) Selection 
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Trend format.  

Choose any field of date format like birth date, join date, and so 
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Table 12 describes the Pie chart selection.

 

Features 

Pie chart  

Label dropdown menu  

Value dropdown menu 

 

Table 12  Description of Pie (Chart) Selection 
 

5.6.4 Plot Selection 

 

Figure 5-31 shows the Plot (chart) selection of the 
 

 

Table 13 describes the Plot (chart) selection.

 

Features 

Plot chart  

X-axis dropdown menu  

Y-axis dropdown menu 

 

Table 13  Description of Plot (Chart) Selection 
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chart selection. 

Description 

By choosing chart type Pie, the chart appears in 

Pie format.  

 Choose any label from the dropdown list. 

 Choose any value from the dropdown list.

Table 12  Description of Pie (Chart) Selection  

(chart) selection of the Chart tab. 

Figure 5-31 Plot Selection 

(chart) selection. 

Description 

By choosing chart type Plot, the chart appears in 

Plot format.  

 Choose any field from the dropdown for the

 Choose any field from the dropdown for the

Table 13  Description of Plot (Chart) Selection  
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, the chart appears in 

 

. 

 

, the chart appears in 

the X-axis. 

the Y-axis. 
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5.6.5 Bar Selection 

 

Figure 5-32 shows the Bar chart selection of the 
 

 

Table 14 describes the Bar (chart) selection entries.

 

Features 

Bar chart  

Label dropdown menu  

Value dropdown menu 
 

Table 14  Description of Bar (Chart) Selection 
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chart selection of the Chart tab. 

Figure 5-32 Bar Selection 

(chart) selection entries. 

Description 

By choosing chart type Bar, the chart appears in 

Bar format.  

Choose any label from the dropdown list. 

Choose any value from the dropdown list.

Table 14  Description of Bar (Chart) Selection  
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, the chart appears in 

 

opdown list. 
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5.7 Gauge Tab 
 

In the Gauge tab, you can add a panel of radial or linear gauges to a report.   

 

 
Figure 5-33 Gauge tab contents 

Results:   Allows you to specify how many gauges you want to show, if you choose to count the  

   number of products in multiple categories, you could specify that you want to only  

   show the first 4 categories by alphabetical order. 

 

Name:      Choose the gauge labels 

Value:      Chose the field to which a function is applied. 

Function:   Choose a function to apply to the field.   

Radial/Linear:  See table below. 

 

Radial gauge 

 

Linear gauge 
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5.8 Misc Tab 
 

In the Misc Tab, you can add a title and description of the report. Scheduling is also done in the Misc 

tab. 

 

 
Figure 5-34 Misc tab contents 

 

 

Title:     Enter the title of the report.   

Description: Enter a description for the report.  

Header:    Allows a user to set a report header.  

Footer:    Allows a user to set a report footer. 

 

Shared/Read only:  Selecting “Shared” will allow other users to see your report and modify it.  Selecting 

“Read only” set the report so that it is only modifiable by the report owner.  

 

Category:  Set the category of the report.  Note:  this is set automatically when you save with a 

category. 

 

Note: The scheduling controls may not be available to all users, if you do not see them, please speak 

with your system administrator. The scheduling controls allow you to schedule a report to be emailed 

on a recurring basis. 

 

Schedule:   Set the schedule date and time.   

Repeat Type:  Set the repeat frequency. 

Send Email As:  Sets the format in which the email is sent. 

Recipients:   Enter a comma separated list of recipients. 
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5.9 Style Tab 
 

In the Style tab, you can customize the look of the table.  You can change the color of the border, 

header, and rows.  The order of report items can also be changed. 

 

 
Figure 5-35 Style tab contents 

 

 

 

 

 

Report style properties can be changed using the drop-downs, when the properties are changed, the 

sample grid below can be used to see the differences.   
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The colors which can be changed are: Border color, Header color, Header foreground color, Item color, 

Item foreground color, and Alternating item color. 

 

Explanations of other properties found on tab are given below. 

 

Landscape printing:       Determines whether the report prints in landscape mode. (can  

also be set using print properties in the printer dialogue box) 

Show page number in pdf:     Sets whether the page numbers are shown in pdf report  

exports. 

how date and time in pdf:     Sets whether the date and time are shown in  pdf report  

exports. 

 

Use pagination in web view:    Sets whether pagination is used in the report viewer. 

 

Add bookmark for each visual group:  Sets whether bookmarks are used in adobe pdf exports. 

 

Show Visual Group Label:     Sets whether the visual group labels are shown. 

 

Items per page:        Allows a user to set the number of items show per page in a grid. 

 

Report order:         Allows the user to set the order of the Summary, Chart, Gauges  

and Detail grids 

 

  

Field|Value column pairs:     Allows a user to set the field value style.  This is useful for  

Accounting/financial reports. 

 

Show main report in Field | Value style:  Allows a user to set whether the main detail grid uses  

Field-Value style 

 

Show summary report in Field | Value style: Allows a user to set whether the summary grid uses 

Field-Value style 
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5.10 Preview Tab 
 

In the Preview tab (Figure 5-36), a preliminary version of the created

its Summary Table, description, and chart. Go back and change select

how they affect the  table by returning to it in the 
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), a preliminary version of the created table can be viewed, along with 

and chart. Go back and change selections in the previous tabs and see 

how they affect the  table by returning to it in the Preview tab. 

Figure 5-36 Preview Tab 
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can be viewed, along with 

ions in the previous tabs and see 
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5.11 Toolbar 
 

Figure 5-37 shows the Toolbar buttons. 
 

 
Figure 5-37 Toolbar Buttons 

 

Table 15 describes the functions of the Toolbar buttons. 

 

Icons Features Description 

 Back Goes to the browser’s previous page. 

 New  Creates a new report. 

 Save Saves a report. 

 Save As  

 Print (PDF Export) Saves the report as a PDF document. 

 IE Runs the report in the web browser. 

 Schema  

 SQL Views the report in SQL mode. 

 CSV Saves the report as a CSV file. 

 Excel Spread sheet Saves the report as a MS-EXCEL file. 

 Word Document Saves the report as a MS-Word document. 

 XML document Saves the report as a XML document. 

 
Open office 

document 

Saves the report as an Open Office Document. 

 RTF document Saves the report as a RTF document 

 Back to Report List  

 E-mail E-mails a report to a client 

 Settings  

 
 

Table 15 Description of Toolbar Buttons 

 

5.11.1 Back Button 

 

Use this button to go back to the browser’s previous page. 
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5.11.2 New Button 

 

Use this button to create a new report

existing report is refreshed. 

5.11.3 Save Button 

 

The Save button is used to save any report, created with a specified name, in the saved reports list. 

Figure 5-38 shows the Save Any Report script prompt
 

5.11.4 Go Button 

 

The Go button is used to run a particular report in t

report as an HTML report (Figure 5-39
 

Figure 5-
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Use this button to create a new report according to your query. The new report is created, 

button is used to save any report, created with a specified name, in the saved reports list. 

ve Any Report script prompt. 

 
Figure 5-38 Save Any Report 

button is used to run a particular report in the web browser. It opens a new page to show the 

39). 

-39 To Run the Report as a HTML Report 
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according to your query. The new report is created, and the 

button is used to save any report, created with a specified name, in the saved reports list. 

new page to show the 
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5.11.5 SQL View 

 

This button is used to view the report in SQL view (Figure 5-40). It allows the report to be opened 

directly or saved for future use. 

 

 
Figure 5-40 Save Any Report as SQL Format 

5.11.6 PDF Button 

 

The Pdf button is used to save any report as a .pdf file format that can be used later. Specify the 

location and the file name for better identification. Figure 5-41 shows the file download screen. 
 

 
Figure 5-41 Save Any File as PDF Format 
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Figure 5-42 shows the screen displayed after the download is complete. 
 

 
Figure 5-42 After Completed Download 

 

5.11.7 CSV Button 

 

The CSV button is used to save any report in a specified location as a .CSV format, which can be 

retrieved later. 

 

5.11.8 Spread Sheet Button 

 

The Spread Sheet button is used to save any report in an MS-EXCEL file format , which can retrieved 

later. Specify the save location and the file name. 
 
 

5.11.9 Word Document Button 

 

The Word Document button is used to save any report as an MS-WORD document, which can be 

retrieved later. Specify the location and name only. 
 

5.11.10 XML button 

 

The XML button is used to save any report as an XML document, which can be retrieved later. Specify 

the location and name only. 
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5.11.11 Open Office Document 

 

This button is used to save any report as an Open Office Document, which can be retrieved later. 

Specify the location and name only. 

 

5.11.12 RTF Document 

 

This button is used to save any report as an RTF Document, which can be retrieved later. Specify the 

location and name only. 

 

5.11.13 E-mail Report 

 

This button is used to e-mail the report to a client. Specify the e-mail address of the recipient only. 
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6.0 FUNCTION DESCRIPTIONS 
 

The following is a table of functions available for use in the Fields and Summary tab of the Report 

Designer. 

 

Function Name Description 

Group Groups field values together for aggregating 

Count Counts the number of values in a column 

Count Distinct Counts the number of distinct values in a column 

Sum Sums the value in a field 

Average Takes the average value of a field 

Maximum Takes the maximum value in a field 

Minimum Takes the minimum value in a field 

Group(Date),(Day),(Month),(Year) Groups  a date field by its value 

Group(Month Name) Groups a date field by its month value and 

displays the name (March) instead of (03) 
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7.0 GLOSSARY 
 

Database  A collection of data arranged for ease, speed of search, and retrieval. 

   

Entry  A single piece of data that belongs to a field. 

   

Field  A set of entries that are grouped together because of similar properties. 

The Fruit field contains entries that are either apple, peach, or orange. 

   

Table  A set of data organized into fields and arranged in rows and columns. 

   

View  A set of tables that have been joined by similar fields with identical 

entries. 

   
 


